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User Guide Revision History

Document Number: MRK-D-0014
Product Version: 1.2

Document Version: 4

Date released: March 2013
Description: User Guide for Dust Sentry

This User Guide is a newly created document for the use of the Aeroqual Dust Sentry.

Date Revision number Description of change Affected pages
May 2011 V1 Initial draft
March 2013 V2 Improved accuracy and All
readability
August 2013 V3 Updated for DS 1.2 All
Added information on Pg. 10-11 and
October 2013 va Orbit Data and Gatetel Pg.44-47
Modem
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1. Description

Aeroqual’'s Dust Sentry is a user friendly instrument designed to provide reliable real time indicative
particulate measurement of PM10, PM2.5 or PM1 using a well proven near forward light scattering
nephelometer and high precision sharp cut cyclone.

The instrument includes an integrated internal data logger, alarm relay outputs and a SD card as
standard. There are also numerous additional options available, including, wireless communications,
SMS and email naotifications, weather sensors and GPS. The instrument is packaged in a robust,
lockable enclosure and is light enough for one person site installations. The ease of installation, as
well as the extensive range of possible add-ons, enables the unit to be used in a wide range of
applications.

Modem Antenna
(Optional)
PM Optical Engine

Sample Filter
Auxiliary Module Purge Filter
(Optional)
Pump Module
Analogue Output
Module (Optional)
Sample Filter
(Optional)

Power to Sensor Modem (Optional)

Relay Alarm Relay
pr—— § v Control Module
RS232 to USB
Adapter
Note: 12 VDC Power Supply mounted externally at base
The key components of the Dust Sentry are described below.
MRK-D-0014, V4 Page | 5
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1.1. Nephelometer

Aeroqual uses a Nephelometer optical sensor from Met One Instruments. The optical sensor uses
light scattering from particulate matter to provide a continuous real-time measurement of airborne
particle mass. The light source is a visible laser diode and scattered light is measured in the near

forward angle using a focusing optics and a photo diode.

The Nephelometer has an on-board temperature sensor which corrects for thermal drift, sheath air
filter to keep the optics clean, automatic baseline drift correction and a fibre optic span system to
provide a check of the optical components.

Safety: This sensor is considered a Class | laser product. Class | laser products are not

A considered to be hazardous. There are no user serviceable parts inside the cover of
the sensor. The device contains a laser operating at 670 nm which is visible to the eye
and can cause damage to the eye if directly exposed. Only trained service personnel
should attempt servicing or repair of the sensor.

1.1.1. Electrical connections to Nephelometer
The electrical connections to the Nephelometer are summarised below:

Wire colour Function
Orange (x2) Fibre optic solenoid
Red 5V (power in)
Black Ground
White Signal out (0-5 V)
Black/white Signal Ground
Yellow Laser current monitor ( 10mV = 1 mA laser current)
Grey Temperature output

1.1.2. Inlet heater

The Dust Sentry uses a 12 V heater on the sample inlet tube to reduce the humidity of sampled air to
prevent particle growth and fogging of the Nephelometer optics in high RH conditions. The inlet
should always be heated.

1.1.3. Inbuilt filters

The Nephelometer contains two filters which should be replaced at specified intervals (see
Maintenance Section 4). The “Sample” filter is a coarse filter designed to protect the sample pump
from excessive particle build-up. The “Purge” filter is a fine filter which filters the sheath air flow and
also produces particle-free air during the auto-zero cycle.

MRK-D-0014, V4 Page | 6
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1.2. Pump Module
The Pump Module contains a microprocessor for mass calculation and a pump for sampling. The
schematic is shown in Section 8.

Sample line
Purge air line with
flow adiuster

12VDC power Fibre span switch

connection
Inlet heater connector

Cable from optical engine.

Exhaust line with flow
adjuster

1.3. Control Module

The control module is the interface between the RS485 sensor bus and data communication links. It
contains a display, an SD data card which logs data, a RS232 serial connector for external
communication, a bus connector for internal communication with the sensor modules and a cable
connector for the optional Humidity and Temperature sensor (if fitted).

Front

Display

Top
RJ45 RS485

2 way Bus relay DB9 RS232

activation
2.1mm 12VDC relay
switched Power output 4 way T/RH

6 way Alarm Relay SD Card Slot
Page | 7
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Bottom
Programming Port

Controller 12VDC RS232

power input

Off/On switch with LED.
Depress to power on (blue
LED on)

Programming Dip
Switch (position is
important)

The Dust Sentry is supplied with a RS232 to USB adapter fitted between the Control Module and an
external USB socket fitted at the base of the enclosure. This enables the user to perform a wide range
of functions over the USB connection, without needing to open the enclosure door, such as data
logging and various system checks using the supplied Aeroqual Dust Sentry PC software

Note 1: The driver for the RS232 to USB adapter is in the software CD which comes with the
instrument.

Note 2: The power to sensor and alarm relays are also attached to the control module base
plate.

1.4. Power Module

The Dust Sentry internal power requires regulated 12 VDC to

maintain a constant pump speed. An external mains to " B om ‘ ; '
12VDC power supply (Meanwell HLG80-12A 60W 12V) is e LIS O A o
fitted on the outside of the enclosure and this will allow

connection to mains supply.

Note: If you wish to run the Dust Sentry on solar power you will need to use a DC-DC
convertor in order to supply a regulated 12 VDC for the Dust Sentry — refer to the application
notes on the website

1.5. Auxiliary Module (Optional)

The auxiliary module acts as an interface between third party sensors and the Dust Sentry
communication bus. It is configured with different operating modes which can be selected by using
the dipswitches located on the side of the module. Aeroqual has integrated a number of third party
sensors and is able to supply the auxiliary module preconfigured for your sensors.

Firmware: AUX_MODULE_01.
Use for: Analogue inputs, Vaisala WXT520 weather, Gill Windsonic wind, Cirrus MK:427 noise.

1 2 3 4 Function

OFF | OFF | OFF | OFF Default - standard Auxiliary module with AN1, AN2, Freq

ON OFF | OFF | OFF Vaisala WXT520 with RS232 communication + AN1, AN2, Freq

OFF ON OFF | OFF | Vaisala WXT520 with RS232 communication + Cirrus MK427 Noise

ON ON | OFF | OFF Wind Sonic with RS232 communication + AN1, AN2, Freq
OFF | OFF | ON | OFF Wind Sonic with RS232 communication + Cirrus MK427 Noise
ON | OFF | ON | OFF Cirrus MK427 Noise module only
MRK-D-0014, V4 Page | 8
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Firmware: AUX_MODULE_02.
Use for: Analogue inputs, Met One MSO weather, Met One 034b wind, Cirrus MK:427 noise.

1 2 3 4 Function
OFF | OFF | OFF | OFF Default - standard Auxiliary module with AN1, AN2, Freq
ON | OFF | ON | OFF Cirrus MK427 Noise module only
OFF | ON ON | OFF Met One MSO with RS232 communication + Cirrus MK427 Noise
ON ON ON | OFF Met One MSO with RS232 communication + AN1, AN2, Freq
OFF | OFF | OFF | ON Met One 034B analogue module + Cirrus MK427 Noise

12VDC Power
Connectors

Status LED —M—>

RJ45 Connectors
for RS485 bus

1.5.1.

PIN 1:
PIN 2:
PIN 3:
PIN 4:
PIN 5:
PIN 6:
PIN 7:
PIN 8:
PIN 9:
PIN 10:
PIN 11:
PIN 12:

Wiring of Auxiliary Module

GND

12V FUSED
RESERVED
RESERVED
RX

X

0-5V IN
4-20mA IN
FREQIN
AGND
METONE 034B PWR
TIMED RELAY

MRK-D-0014, V4

Pin 12

Programming
Port

Programming Dip
Switch
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Example of wiring:

. . (Pin 1) GND, . . .
Wind Sonic SIGNAL GND (Pin 2) 12V (Pin 5) RX (Pin6) TX
(Pin 1) GND for .
Vaisala operating, data & (Pin 2) 12V for (Pin 5) RX (Pin 6) TX
; operating & heating
heating
(Pin 1) GND,
Met One MSO SIGNAL, (Pin 2) 12V (Pin 5) RX (Pin 6) TX
COMMON, SHIELD
Met One 034B (Pin 1) GND (Pin 12) VCC (Pin7) WD (Pin 9) WS
. _ (Pin 1) GND, (Pin2) 12V, LOOP | _ (Pin 12)
Cirrus MK:427 |\ GCTUATOR GND IN (Pin 8) LOOP OUT | )\ cTUATOR IN

A programming port is also exposed through the side of the module to allow custom programs to be
loaded into the module.

Note: Aeroqual can supply a standard programming tool for distributors to reprogram the
auxiliary module to the specified requirements.

1.6. Analogue Output Module (Optional)

The Dust Sentry has the option to integrate an ADAM 4021
Analogue Output Module into the system to allow for the digital
inputs of a chosen sensor to be converted to an analogue output. o ‘%
The analogue output module receives the digital input via an
RS485 interface and converts it to a 4-20mA and 2-10V output.
These outputs follow each other.

Outputs:
4mA (2V) = 0% of full scale value.

12mA (6V) = 50% of full scale value.
20mA (10V) = 100% of full scale value.

The module is easily configured via the Operations menu in the PC software and can convert to an
analogue output any chosen sensor already integrated in the Dust Sentry. The module uses the
logging period to calculate the reading, which is also set in the Operations menu. This differs from the
alarm relay, SMS and email which all use the averaged alarm period to calculate the reading. For
more information regarding the PC Software and setting up the analogue output module please refer
to Section 3.1.

1.7. Gatetel GT-HE910_G Cellular Terminal (Optional)

Aeroqual can provide a Gatetel GT-HE910_G
Cellular Terminal with GPS for remote data
access over GSM, GPRS or SMS networks.
Please read the Gatetel GT-HE910_G Cellular
Terminal manual for detailed instructions on
configuration and use. Further information can
be found at:

http://gatetel.com/products.php?product=22

MRK-D-0014, V4 Page | 10
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Features

Incorporates Telit HE9Q10-DG
module

The Telit module handles all GSM/UMTS GPS
processing with PYTHON script

Frequency bands

GSM: 850/900/1800/1900MHz
UMTS/HSPA+: 800/850/900/1700/1900/2100MHz

Power supply

Single supply voltage 6V DC to 55V DC
connector 4 pin micro-fit 3mm

ADC and GPIO inputs

Two outputs optocouplers open collector drive 100ma
Two inputs optocouplers, 0-55v

One ADC 10 bit , 0-55V

connector 6 pin micro-fit 3mm

Communication

Modem Full RS232, connector D-Type 9pin (DB-9)
Modem USB, Connector USB Type B High retention

Antennas

GSM/UMTS GPS via SMA connectors

Mechanical Description

Weight

180g (6.3502)
0.4 1b

Dimensions(max) L x W x H

83mm x 64mm x 34mm 3.26inch x 2.51inch x 1.33inch

Case material

Aluminum

Environmental Requirements

Operating temperature range

-20°C to +55°C

-4°F to 131°F

Ambient temperature

The module is fully functional in all the temperature range
and it fully meets the ETSI specifications.

-30°C to +70°C

-22°F to 158°F

The module is fully functional (*) in all the
temperature range. Temperatures outside of
the range —20°C to +55°C (-4°F to 131°F) might
slightly deviate from ETSI specifications.

Humidity

5% - 85%

1.8. Electrical Connections

RS485 Bus

The two wire RS485 bus connections are made using 20 cm CAT5 cables between the sensor
modules. The last module on the bus also has a blue termination dongle fitted.

Note: If the optional Analogue Output Module is fitted the termination dongle is not fitted.
Instead termination resisters are fitted in the RS485 cable that terminates at the Analogue

Output Module.

12 VDC Power Bus

All modules inside the Dust Sentry operate from the 12VDC power. The power is supplied by a daisy
chain of black and red cables. A relay is activated by the Control Module on/off button to allow the

sensor bus to be powered.

MRK-D-0014, V4
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12 VDC Power in
12 VDC power is connected into the instrument at the terminal connector strip (“chock bloc”).

1.9. Alarm Relay

The Dust Sentry has a built in alarm relay function that is set up via the Operation Dialog in the PC
software (See Section 3.1.)

Relay Output: This is fitted as standard and is activated by “Enable Alarm Relay Output” tick box. If
the set point set in “Alarm trigger point” is exceeded the relay is activated. This can be used to
activate a siren or strobe or other peripheral devices. The relay remains activated until the measured
value drops below the reset point (expressed as a % of the trigger point). This is controlled via the
“Alarm reset point of trigger”. The “Alarm trigger point average period” determines the amount of time
that the concentration needs to be exceeding the trigger point before the relay is activated.

If “Active output on diagnostics” is selected the alarm will trigger upon sensor failure or sensor no
report. If not selected the alarms remain in the state they were in when the last valid reading was
logged.

The Alarm relay is energised by the Control Module in response to the alarm trigger point. The trigger
point is programmed into the Control Module via the Operation menu in the PC Software. The Alarm
Relay is a double pole; double throw type (see diagrams below). This allows the connection of two
different alarm signals — e.g. siren and strobe - that may have different power requirements.

The relay contacts rating: 10A @ 24VDC 220VAC.
Coll

Normally Open A Normally Open B

Common A Common B

Normally Closed A —> Normally Closed B

Relay Internal Schematic

colL COMA
COMB
' NC.A
NO. A
colL oy
N.O. B
MRK-D-0014, V4 Page | 12
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2. Assembly and Installation

2.1. Assembly of heated inlet

Parts List:
A. Inlet Tube/Heater including power cable
B. Sharp Cut Cyclone (if fitted)
C. TSP Inlet

A A A

i. Connect parts A,Band C

iii. Open door of enclosure and remove protective cap from the optical engine

Protective
Cap

iiii. Insert Inlet Tube Assembly through base mount and fix the three mounting screws

3x M3 Mounting
Screws

Note: Ensure the power cable is fed through the inlet hole when connecting

MRK-D-0014, V4 Page | 13
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iv.  Connect power to Inlet Tube/Heater inside the enclosure

Heated inlet power cable

2.2. Connect Mains Power
ﬁ Caution: The high voltage mains supply must be wired by a certified electrician

in compliance with local electrical regulations.

e Locate the power connector terminal which is situated outside the enclosure at the bottom.
The power supply will already be wired to the connector however the cable to connect to
mains power needs to be wired.

1. Unscrew the nut
gland to loosen the
terminal block and pull
connector apart

Nut gland
Plug Neutral
Connector \L
Terminal block l/ i
> Earth (Brown)
(Yellow/Green)

2. Feed the power cable through the nut gland 3. Reconnect into the connector

plugs and connector and wire the cable to the ensuring the plugs are fitted securely

terminal block according to the diagram. and the nut gland tightened.

Note: To remove the terminal block from inside the connector unclick it from the casing by
turning it slightly then pull out

MRK-D-0014, V4 rage | 14
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2.3. Sample Collection Filter (Optional)

The Dust Sentry can be fitted with a 47mm collection filter holder if requested. It is used to collect
particulate samples for composition analysis.

Note: If the Dust Sentry is shipped with a sample collection filter holder, it
will not contain a filter on arrival.

If you wish to use the sample collection filter:

1. Remove the internal sample filter from the 80180 optical engine (See 4.2.8)
2. Unscrew the collection filter housing and insert a 47 mm filter.

3. Tighten the collection filter housing.

4. Check and adjust the sample flow to 2.0 LPM

MRK-D-0014, V4 Page | 15
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3. Dust Sentry Operation and Software

3.1. Getting Started

Computer Requirements

CD-ROM Drive or internet connection for software download

RS232 serial port or USB — RS232 serial port converter and USB cable (included)
Windows OS version 2000 or later

Minimum 100 Mb of spare hard drive space

Recommended 512 Mb RAM or more

Recommended 1 GHz processor speed or faster

1. Once the Dust Sentry is assembled and power is connected install the SD card into the control
module.

2. Start the Dust Sentry by pushing the on/off switch on the control module (See Section 1.3 for
location of On/Off switch)

3. Connect the instrument using a computer via the USB cable to the outside of the enclosure

4. Install Aeroqual Dust Sentry software. This can also be downloaded from the Aeroqual
website at www.aeroqual.com

5. Launch the Aeroqual Dust Sentry PC software. rigj,Log ini dﬁbﬂq‘_ﬁﬂ’
a. Select to log in as either: r...._.

o User (default password = “password”)
o Engineer (default password = “aeroqual”)

Log in user

@ USER. () ENGINEER

=

Note 1: User has access to most day to day functions on the Password: |

instrument. Engineer has access to all functions, including
diagnostic parameters (Sensor Module Settings and Sensor | ok | [ cencel |
Diagnostic View). I i

6. Configure the Dust Sentry instrument:
a. Select Setup > Communication Port
b. Select Serial Port RS232 and the relevant Com port. Press OK when complete.

Note 2: The settings should be as seen below:

Note 3: To connect via the modem select TCP/IP Socket and enter the network IP address and
port number. If the PC is behind a proxy server this information needs to be added as well.

MRK-D-0014, V4 Page | 16
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7. Check configuration

e Select Setup - Configuration
e Check the correct sensors in the Dust Sentry have been configured.
e These should match the sensors on the invoice and the sensors list in the instrument logbook.
e Click Save and Close.

-
& Dust Sentry Configuration Dialog

Monitor Current ID:
Monitor Mew ID:

Sensor Mumbers:

Sensor Type List U=ed Sensor List:

TSP
PM1
Leq

W5

AM1
AMNZ
Freq i

L] ¥

PM2.5
PM 10

[ ] [0 )

8. Set Dust Sentry Real Time Clock
Click on Tools - Update Real Time Clock (this will synchronise the Dust Sentry

a.

clock with the computer date/time)

9. Configure the operations

a.

b.

C.

MRK-D-0014, V4

Select Setup = Operations.
Enter Data Logging Period

If the alarm relay is being used please check
“Enable Alarm Relay Output’

Select the output sensor and set the Alarm
trigger point. The alarm will go off when the
concentration reaches above the
concentration set for the selected sensor.

Select the reset point of trigger. This is the
percentage of the alarm trigger
concentration at which the alarm will reset.

Select the alarm trigger point average
period. This signifies the time interval at
which the average is calculated for control of
the alarm.

Note: The alarm average period must be
greater than or equal to the data report rate

-
& Dust Sentry Operation Dialog

Maonitor 10
Data Logging
Data Logging Period {hhi:mm) :
@ Auto Data Report
() Poling Data
Output Settings
Selected Sensor :
Alarm trigger point  (ug/m3):

Alarm reset point of trigger {%%):

[7] Active output on diagnostic
[¥] Enable alarm relay output
["] Enable 4-20 mA madule

[7] Enable 5MS message alert
[7] Enable email alert

[#] Use GateTel modem

Alarm trigger point average period:

1 min

Aeroqual Dust Sentry User Guide, March 2013
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g. If the analogue output module is being used please select “Enable 4-20 mA module”.
The module will follow the “Output Sensor” selected.

Note 1: If “Active on diagnostic” is set the analogue output will go to full scale upon No Report
or Sensor Failure condition. If not selected the analogue output will remain in the state it was
in when the last valid reading was logged.

Note 2: When the particle monitor zero calibration is taking place the analogue output module
does not update, i.e. it remains in the state it was in immediately prior to the zero calibration.
The module remains in this state until the zero calibration is finished, then updates on the next
valid reading.

h. If the modem is being used please select “Use GateTel modem”. Once this has been
checked the option to enable email and SMS message alerts will appear. (Refer to
Section 3.3. for information on connecting and using the modem features)

10. Start data-logging to confirm sensor communication and operation is correct.
a. Click Data > Table > Real Time to launch real time data table.
b. Click File > Start Data logging. Data will start being displayed in Real Time Table.

3.2. System Checks

The following are a list of checks that should be performed to ensure the communications are working
correctly and the data is being logged properly. If there is an issue with one of these checks please
refer to Section 4 or contact Aeroqual for technical support.

1. With the Dust Sentry on, open the door and observe the display on the controller. This should
be scrolling with sensor readings.

2. Connect a USB cable to the port on the Dust Sentry enclosure and connect to a PC running
the Dust Sentry PC software. Confirm that you can communicate correctly with the
instrument.

3. Verify the Dust Sentry is data logging correctly to the SD card by clicking “File > Download
Files” on the PC software. A daily log file (DLYYMMDD.AQL) containing the DUST SENTRY
sensor data is created each day. Also system events such as power on, configuration
updates, calibration events and system faults are logged to an EVENTLOG.AQL file.

4. Confirm that the Real Time Clock setting and Configuration is correct.

5. Confirm all of the sensors installed in the Dust Sentry are logging onto the SD card log files
and in the real time table in the PC software. If not check that all the sensors are loaded in
Configuration menu

3.3. Modem configuration

If the Gatetel GT-HE910_G Cellular Terminal is purchased with the Dust Sentry it will need to be
configured using the PC software. Firstly, the modem requires a suitable SIM card (not supplied) that
matches the configuration.

Note: The SIM card needs to be pushed into the modem with the electronic tile facing upwards.

MRK-D-0014, V4 Page | 18
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Configure
e Select Setup = Configure GPRS Modem
e Enter the SIM card provider's APN and username and password if applicable

Note: To use the modem in Server Mode requires an unrestricted APN that can accept
connections

e Click save
e Select Operating mode and select one of the operating modes
e If using Dyn Org service:
Dyn server name is: members.dyndns.org
Dyn login name is: your account log in name
Dyn login password is: your account log in password
DynDNS host name is: the name you have configured for this instrument

Note: You must reboot the Dust Sentry after saving the Dyn Org parameters.

“F GPRS modem configuration - ﬂ r.g GPAS madem configuration = ﬁ1

509 crd properes| Operatng mode | [ 51 card qinceeerties | Oparatrg made|

) Chent modes

Provides APH:  nitemel |

Server aporess LRL:

Username! | Srver port: [i 50,000
: | @ Server made

Cornection port: A1 =

|7 Enabie madem frewall

ot T ackdeeiss . | 000, 000,000,000 |

Irecaming TP retmasts | 000009000, 000

[i7] Lise Bym Eirg serice

T servEr rame: {memibers. dyndns ang
Dy lagn name: {eeraguell
Dynlognpasivord:  |eesssanes

i DylHiShostrame: |getsimodem. dymaias.com

The modem has the following operating modes:

1. TCP Client Mode:
¢ |P and domain name support
e Destination address and port
o Dust sentry connects to chosen server and data accessed via server.

Note: There is no remote access to the Dust Sentry using this mode, except via the designated
server.

2. TCP Server Mode:
. DDNS support for fixed or dynamic public IP addresses (using dyndns.org)

o Optional firewall to restrict which IP addresses can connect to Dust Sentry
. Set TCP port
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3.3.1.  Further information about IP address solutions using GPRS
Systems

GPRS is a communication technology that allows data acquisition systems to overcome the difficulty
of cabling for wide area remote sites. GPRS applications are becoming more prevalent, but the
dynamic IP address issues associated with GPRS networking continue to frustrate system integrators.

The trouble with 1/0 devices with GPRS capability is that they receive a different IP address every
time they connect to the GPRS network.

Three distinct solutions have been developed to overcome this challenge:
Solution 1: Public Static IP Address

The first option is to obtain a public static IP address; some carriers (telecom service providers) can
assign a static IP address to a specific SIM card. This way, all the I/O devices will have their own
static IP address. The main benefit of this solution is that it behaves like a wired solution. However,
not all carriers offer this kind of service.

Solution 2: VPN Service Provided by Carrier/MVNO

A VPN (Virtual Private Network) is a secure LAN solution that groups specific devices together. The
VPN grouping concept solves the dynamic IP address issues and prevents unauthorized persons
from accessing the data. For this VPN solution, customers are required to buy one of a number of
different GPRS on-line services to be able to access a Virtual Private Network (VPN). When the
GPRS device dials up, the carrier will assign a private IP address which is on the same network
segment as the host and can maintain bi-directional communication using a polling architecture. Many
enterprise clients turn to mobile virtual network operators (MVNO). These MVNQO’s acquire numerous
GPRS services and then rents them out to customers who are looking for a small number of IP
addresses.

Unfortunately, some countries do not have MVNOs, and some carriers do not provide VPN services.
For this reason, this solution may be unfeasible for some users.

Aeroqual has used www.wyless.com successfully to communicate with AQM instruments.
Solution 3: DDNS

Using dynamic IP addresses is often necessary since many ISPs do not provide static IP addresses.
The Dynamic Domain Name System (DDNS) is used to convert a device’s name into a dynamic IP
address so that remote devices can communicate with the control centre using a fixed domain name.
DDNS takes care of the Dynamic IP address of a device, and DNS the static IP address of a device.

With most remote GPRS devices, you need to apply for a hostname for each of the devices handled
by the DDNS server. When GPRS devices get an IP address from the carrier, they will automatically
connect to the GPRS network. Each time a GPRS device’s built-in DDNS client gets a new IP
address, it will send the IP address to the DDNS sever.

Aeroqual has integrated the “DynDNS Pro” service from http://dyn.com with your GateTel
modem. For a small annual fee you can configure up to 30 host names to use with up to 30
modems.

3.3.2. Email Message
This function assumes the modem is fitted and correctly configured. It is activated by the “Enable

Email Alert” tick box under Operations. Up to 5 Email recipients can be connected at once.
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e Select Setup > Email Recipients and enter the Email server and Email recipients

e NOTE: the SMTP server will typically be one provided by your SIM card provider. The user
name and password are often not required.

[ Reoglent Emails Canfiguration HEH [ Reapient Emads Configuration ﬁ
ﬁ Emad Server | Emad Recivents| | ﬂ Emad Server, | Emad Recpients
= Serit Bl o Sotnes | Fleciient Emal Addremeas
Emei Address: | | !
) Ernad Addrecs Lt |
ST Server: |
: ! Emad Ak oca 2 |
User Mamaz 1
Emai Addrezs 3: |
- = Emmail Ak ess 4; |
Emad ackess 5; =
|
| [ ok || cance | oo ] | Cancel

3.3.3. SMS Message

This function assumes the modem is fitted and correctly configured. It is activated by the “Enable
SMS Alert” tick box under Operations. Up to 5 SMS recipients can be connected at once.
e Select Setup = Mobile Recipients and enter the relevant mobile phone numbers

Note: The country code needs to be included e.g. +44

@ Redpient Mobile Settings
. Mobile number 1: |

Mobile number 2:
Maobile number 3:
Maobile number 4:

Mobile number 5:

3.4. Software Description Summary

The Dust Sentry Software is designed to be a simple interface for communicating with the Dust Sentry
monitor via a PC. It can be used to configure the instrument, initiate the zero calibration routine,
modify gain factors, poll data and display the data in either table or graphical format. The software
runs in Java VM1.5 (supplied with software) and the database is an open source HSQLDB Java
database. Data can be easily exported to a spread sheet for processing. The software also
incorporates a TCP/IP modem connection which can be used to connect to and operate a Dust Sentry
unit remotely.

3.4.1. File
Search monitor Searches for available Dust Sentry monitors
Connect to Monitor Connects to Dust Sentry
Start Data Logging Starts data logging from the Dust Sentry
Stop Data Logging Stops data logging from the Dust Sentry
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Export Logged Data
Import Files
Download Files

Exports logged data from the Dust Sentry
Imports file (aql file)

Downloads files; including daily files and event log

AelOQUAL

m

5 Dowmioad Fle_

==

20T+ AQL
HLETT A
0 L N0E06. AL
L E0T.AQL
20130608, 50
20 L 0E0%. A
1308 AL
SALICEG LA
HtNE1L AR
2010s TLAQL

LG5 AL
130838 A
[FILCEIT.ADL
21306 a8, AL
[n1ws e A
201 E20. A
20615 A0L
AT A
MIXET A
barame aw

EENTLOG.AQL %K
ALARMOG AT 1508

33
% i3
453
458
1265
KB
5K
LiE
L
i

L
b1
SKB
2
L1
4KE
2KE
1048
(L]
AKE

e T L]

-

S Mk o folden:
C:Lsers D Documents:

[ fave | | Sovetimport | | Smeal | [ ek | [ Ome |

Note: Files can be either saved to the PC only by clicking Save/Save all or saved to the PC and
the database by clicking Save & Import

Update sensor list

Update the sensor list on the database (Manual modification only

available in Engineer Mode)

Sensor Code
OxC7

Sensor Name
TSP

Units
ug/m3

Range
2000.0

FM1

ug/m3

2000.0

Leq

dBA

120.0

PM2.5

ug/m3

2000.0

PM10

ug/m3

2000.0

W3

m/fs

125.0

WD

deg

360.0

AM1

\

5.0

ANZ

A

20.0

Freg

Hz

32000.0

ITEMP

C

100.0

FLOW 1

Ijim

1000.0

RAIN

mmh

500.0

SOLAR

\

5.0

HAIL

fcmz2h

10000.0

DOESC

[Ze}

i lalulsInlal

llmpm_'t]lE)q;bort][Save

| ]

Note 1: Double click on the sensor name, unit or range to be modified and enter the new
information. Click save once modification is complete.

Note 2: The changes made will modify the title headings in the logged data; it will not alter the
readings. This is particularly useful for when AN1 and AN2 are being used.

Zip database Zips the database
Unzip database Unzips the database (prompted by a warning message)
Exit Ctrl X Exits the Dust Sentry software
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3.42. Setup

Configuration Configures Monitor ID, Sensor Modules and Measurement Units

Operations Configures the Data logging interval and Alarm and Analogue Output
functions

Test Connection Tests the connection to the Dust Sentry

Configure GPRS Modem Configures the SIM card properties and operating mode of modem

Mobile Recipients Configures mobile SMS alerts

Email Recipients Configures email alerts

Communication Port Allows setup of the serial COM port and TCP/IP port to communicate

with the Dust Sentry

3.4.3. Data

Graph - Real Time Graphs real time data from the Dust Sentry
Graph - Logged Data Graphs Logged data from the Dust Sentry
Table > Real Time Tabulates the real time data from the Dust Sentry
Table > Logged data Tabulates the logged data from the Dust Sentry
=Tk
Wiew Range
Fromm: Tin Display Conc Unit  ~Manitars
Lzmz ozs | [osoz Lzmz ozs | [te0z “:pm = ‘ %1 j—‘ Ap_plvl
~Table
Monitor ID Date Time FM10{ug)m3)
1 2012 Ock 25 |09:19:12 15.69
1 2012 Ock 25 02112 5,42
1 2012 Ock 25 |09:23:12 9.47
1 2012 Oct 25 02512 3.39
1 2012 Ock 25 002712 3.84
1 2012 Ock 25 0929112 .45
1 2012 Ock 25 03112 3,33
1 2012 Ock 25 035l 14.04
1 2012 Oct 25 |09:40:48 5,10
1 2012 Ock 25 |09:42:48 6.21
1 2012 Ock 25 |09:44:45 .62
1 2012 Ock 25 |09:46:45 5.56
1 2012 Ock 25 0945145 9,31
1 2012 Ock 25 |15:55:31 4,21
1 2012 Ock 25 155731 3.71
1 2012 Ock 25 |15:59:31 346
1 2012 Ock 25 |16:01:51 3.82
Expark | Delete | Clase: |
T E— -
ey P
Scaled Readings i
b5 E‘::I..'D!‘:ﬁ
m II"IIT
el
" e
| e
pol e
ol Mo -
- o
¢ .  TE—
s Dy Conc ik
- L 1 " M " 1 1 i J""" 3
a0y e Ee b Al l.:!-ﬂ LLE L L& H al mis i
W Pl 5 5 R e = |
":l\.ll".rll o
(e ] o |
MRK-D-0014, V4 Page | 23

Aeroqual Dust Sentry User Guide, March 2013



AelOQUAL

3.44. Tools
View Configuration Views the configuration settings of the Dust Sentry
Poll Data (Ctrl D) Polls data from the Dust Sentry (data will appear either in the real
time table or real time graph depending on which is open)
Switch User Change from User to Engineer mode
Change Login User Password Changes the password required for User login
Update Real Time Clock Updates the real time clock to that of the computer
(prompted with a confirmation message)
Reset Timer Resets the timer
Reset Controller Performs a software reset of the Dust Sentry Control Module
3.4.5. Calibration
Control Factors Displays the Dust Sentry’s Gain and Offset factors

Zero Calibration Initiates the zero calibration.

Note: The Gain and Offset can be modified manually by double clicking the unit to be changed,
entering the new value and clicking save.

3.4.6. Diagnostics (Available in Engineer Mode)

Sensor Module Settings Displays the sensor module settings. Click on download all to
display the module settings if not automatically downloaded.
(exportable to text file)

B sensor Module Settings . ﬂjmﬁ

Sersers  |Version| AR | W3 [ mema ] tiee [ e [ vmm | w0 | At | w2 [Perm]pumn] san |
FHID 5.6) 16.00 121.560/580,000) 720.000(S00.000( S.000] 0.028) 1.000 -156..0 180] 160)0.000

Bpot | Oose |
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Parameter | PM10 | Meaning
Version 5.8 Firmware version (software controlling instrument operation)
HTR 16 Not used
H3 101.78 éa):;bgg’;ion parameter taken from Met One calibration certificate
TEMA 580 | Notused
TIMA 720 | Auto zero timing (minutes)
TEMR 500 | Notused
TIMR 5 Auto zero cycle time interval (minutes)
HO 0.01 | The baseline output of 80180 (V)
H1 1 Not used (fixed as 1)
H2 10.077 E:I\/T)I(l:)gzt(l)o)n parameter taken from Met One calibration certificate
PWMH 35 Not used
PWML 3 Factory Module Type. Do not modify
Gain 1 Factory Gain. Do not modify

Note: These are EXAMPLE settings; instrument will have slight variations depending on

calibration and software version releases

Sensor Diagnostics View

_mix
Table
agMiD. | pawe Time PM10LI(mA) | PM10Signal(l) | PMI0Temp(C) | Inlet

1 2013 Aug 19 13:39:15 16.129032 0.019061584 34 Sample

1 2013Aug 19|  13:3%:18 16,129032 0.019061584| 34| Sample

1 2013Aug 19)  13:39:23] 17. 10655 0.019550342) 34| Sample |

1 2013Aug 19  13:3%:28] 17. 10655 0.019550342 34 Sample|

Export | Clear | Close

Parameter Meaning
PM10 Laser (mA) Laser current stable (18 £3 mA)
PM10 Volt (V) Output in Volts (0 to 5V) will vary with concentration
PM10 STemp (C) 80180 engine temperature
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4. Maintenance

4.1. Maintenance Schedule

Procedure Section Frequency
Sample Flow Check 421. Monthly
Purge Flow Check 422. Monthly
Sheath Flow Check 423. Monthly
Manual Zero Air Check 4.2.5. Monthly
Fibre Span Check 426. Monthly
Laser current check 427 Monthly
Filter Changes 42.8. 6 to 12 months
Cyclone and Inlet Cleaning 429 3 Months
Cyclone Disassembly 429 12 Months
Optical sensor factory
calibration Contact Aeroqual 24 Months

Notes 1: Suggested intervals for maintenance procedures may vary with sampling intensity
and environmental conditions.

Note 2: All checks should be carried out during the initial commissioning of the Dust Sentry

4.2. Maintenance Procedures

4.21. Sample Flow Check

A constant 2.0 LPM flow is essential to ensure the sharp cut cyclone is separating out the correct
particle size to be measured e.g. PM10 or PM2.5. To measure the flow, remove the TSP head from
the inlet and connect the volumetric flow meter to the top of the sharp cut cyclone using the adaptor

supplied with the instrument. Ensure the flow meter is on a steady surface before reading the flow
rate.

Note 1: The adaptor tubing should be connected to the TOP of the volumetric flow meter
(negative flow)

Note 2: The flow should be 2.0 LPM

The PM inlet flow can be adjusted via the flow adjuster on the exhaust and purge line.
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o Ifthe flow is less than 2.0 LPM then close the purge flow screw (turn clockwise) until 2.0
LPM is achieved.

o Ifthe flow is greater than 2.0 LPM then open the purge flow screw (turn anticlockwise) until
the flow is 2.0 LPM.

e If you can’t adjust the flow to 2 LPM using the purge flow screw then close (clockwise) the
exhaust flow screw until 2.0 LPM is achieved.

Afterwards replace the inlet components with care, making sure there is no leak.

Purge
adjustment

Exhaust
adjustment

4.2.2. Zero Air Check (Purge Cycle)

The purge cycle is designed to pump air backwards through the optical engine as a cleaning
mechanism. It also acts as a zero air check and adjusts the zero automatically. This will occur every
12 hours (720 minutes) automatically. To manually check the purge flow is operating correctly:

e Select Calibration = Zero Calibration

Use a volumetric flow meter to record the flow using the same steps as measuring the sample flow.

Note 1: The adaptor tubing needs to be connected to the BOTTOM of the volumetric flow meter
(positive flow)

Note 2: The flow rate should be > 0.3 LPM

If the flow is less than 0.3 LPM then open the Purge Adjuster by turning the adjustment anti-clockwise
until 0.3 LPM is reached.

Note 3: It may take a few moments for the purge cycle to complete. The unit can also be
restarted to stop the purge cycle.

Note 4: It is important to re-measure the inlet sample flow rate following a purge flow
adjustment. The sample flow rate must be stable at 2.0 LPM.
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4.2.3. Sheath Flow Check

The sheath flow is a constant stream of air which
ensures the optics remains clean. It is important this
is working correctly to maintain the accuracy of the
measurement. In order to check the flow, a
volumetric flow meter needs to be connected
between the purge flow adjuster and particle engine
as seen in the diagram.

Sample

Note 1: The flow should be approximately 0.2
LPM

/LHHHIUIH

4.24. Leak Check

If the correct sample, purge or sheath flow cannot be achieved, there may be a leak in the pump
module or 80180 engine. First check the entire flow system:

o Remove the purge connection from the module and plug the end of the purge line
¢ Remove the TSP head and block the PM inlet.

e Connect the pressure end of a flow meter to the exhaust port of the module.

o If there is no leak the flow should drop to zero.

(remove to check

. module)
Purge connection

(remove to check
whole flow system)

If the flow does not drop to zero it suggests there is a leak somewhere in the system. To check the
pump module:

o Keep the purge line disconnected.

¢ Remove the sample connection and cap off the module sample port.

e Connect the exhaust port of the module to the pressure end of a flow meter.
e The flow should drop to zero.

If there is a leak in the pump module the module will need to be sent back to the Aeroqual factory.
Please contact technical support.

If there is no leak in the pump module check the tubing and connectors along the flow path carefully.
If you cannot isolate the leak it is likely the leak is located in the engine. In this case, the engine will
need to be sent back to the Aeroqual factory. Please contact technical support.
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4,25, Manual Zero Air Check

A zero air check can also be carried out manually as a way to ensure the purge is working correctly.
To do this the TSP inlet needs to be removed and the particle filter (supplied with the instrument)
needs to be attached to the monitor. Ensure there is a good seal around the cyclone inlet.

s

i

The filter will remove 99.99% of particulates from ambient air. Wait 5 minutes and then check the
readings on the control module. The reported value should be 0 +/- 3 ug/m3. If it is not then the auto
zero cycle is not performing correctly. You will need to check the purge filter (Section 4.2.8) and
replace if dirty and also check the purge flow to make sure it is correct.

4.2.6. Fibre Span Check

Perform a manual zero air check first, then initiate the fibre span by turning the switch on the Particle
Monitor to on. The fibre span check is used to detect any major component failures such as the laser,
photo detector or lens. Wait approximately 4 minutes until the measurement value increases and
record the PM10 measurement from the controller. The fibre span measurement should be within +
20% of the fibre span concentration noted in the logbook. If it is significantly lower, then either the
module optics are dirty or the laser is ageing. Contact Aeroqual for advice

4.27. Laser Current Check.

Refer to Section 3.4.6. to determine the laser current. If the laser current has drifted up or down by
more than 3mA, the engine may need servicing; please contact Aeroqual for advice.

4.2.8. Filter Changes

There are two internal filters which are located on the side of the optical engine. They are designed to
provide protection and to clean purge air. These will become dirty and must be replaced periodically.

To do this, unscrew the filters from the side of the optical engine and replace with new filters. These
can be purchased from Aeroqual. Please contact technical support for a quotation.

Sample Clean
Filter Filter
Dirty
Filter
Purge
Filter ”
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4.2.9. Cyclone and Inlet Cleaning

The dust cap of the sharp cut cyclone will accumulate particulate matter and will need to be
periodically cleaned. Blow out the cyclone with compressed air and unscrew the dust cap and clean.
Replace the cap tightly and ensure there are no potential leaks.

L

The cyclone can be disassembled completely by removing the three Allen head screws and pulling it
apart. The internal parts should be cleaned with isopropyl alcohol once a year.

\

Allen head
screws

o

The TSP inlet can also be dismantled by unscrewing the 3 screws and separating the head into two

parts. Use a lint-free cloth wetted with isopropyl alcohol to clean both the inside and outside of the
inlet.

Screws

4.2.10. Pump Module Removal

The pump module can be removed from the Dust Sentry by unscrewing the 4 screws on the base
plate and sliding the module out. Ensure the Dust Sentry is switched off when removing the module.
The sample, purge and exhaust lines need to be disconnected and all the connected cables removed.
The two main failures which would require removal of the pump module are:

1. Aleak is discovered

2. The pump requires replacement

In both these cases the pump module will need to be sent back to the Aeroqual factory for repair.

Please contact technical support for assistance.

MRK-D-0014, V4 Page | 30
Aeroqual Dust Sentry User Guide, March 2013



aelrOQUAL

5. Calibration

All particle monitors based on light scattering require a site calibration for optimum accuracy. This is
because the average density and light scattering behaviour of dust particles will vary from site to site.
This adjustment is sometimes known as a “K-factor”. Aeroqual recommends a site calibration be
performed at the time of initial installation and then every 12 months. Calibration is performed by co-
locating the Dust Sentry with a Reference Particulate Matter measurement system and adjusting the
Gain of the particle monitor so the average reading matches that of the Reference Instrument. A list of
Reference instruments can be found at:
http://www.epa.gov/ttnamtil/files/ambient/criteria/reference-equivalent-methods-list.pdf

Install the Dust Sentry beside the Reference instrument. Make sure both instruments are setup
correctly. Two procedures are given below depending on whether the reference instrument is a
gravimetric or continuous instrument.

Procedure overview for Gravimetric Reference Instrument

1. Weigh a reference filter and install into the Reference instrument.

2. Leave the Dust Sentry and Reference instrument running for at least 24 hours until a weighable
quantity of particulate matter sample has been collected.

3. Check the sample flows of both instruments to ensure they are within specification.

4. Remove the Reference filter and re-weigh

5. Download the Dust Sentry PM data for the calibration period.

Calculations
1. Reference Filter Weight of PM (ug):
PM(Ref) = (filter weight at finish) — (filter weight at start)

2. Volume of air sampled by reference sampler (m3)
Volume(Ref) = minutes of test * Flow Ref (LPM) /1000

3. Calculate average reference PM density (ug/m3)
AvPM(Ref) = PM(Ref)/ Volume(Ref)

4. Calculate average AQM60 PM (ug/m3):
AvPM(Dust Sentry) = sum(PM readings over test period)/number of readings

Procedure overview for a Continuous Reference Instrument

1. Leave the Dust Sentry and Reference instrument running for at least 24 hours
2. Check the sample flows of both instruments to ensure they are within specification.
3. Download the Dust Sentry and Reference instrument data for the calibration period

Calculations
1. Calculate average Dust Sentry PM (ug/m3):
AvPM(Dust Sentry) = sum(PM readings over test period)/number of readings

2. Calculate average Reference PM (ug/m3):
AvPM(Ref) = sum(PM readings over test period)/number of readings

Calculation of Dust Sentry Gain
1. Calculate K factor
K factor = AvPM(Ref) / AvPM(Dust Sentry)

2. You should then apply this to the Gain Factor on the PM channel.
new GAIN = old GAIN x K Factor
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6. Troubleshooting

Symptom

Possible Cause

Fault isolation/Solution

PM values seem
incorrect

Sample flow incorrect

Sample and/or purge filters dirty
Gain factors incorrect

Offset factor incorrect

Check sample flow and adjust to correct
value using flow adjusters

Replace filters
Perform span calibration

Perform zero calibration

“NR” or “9999” in Data
table(No response)

Occasional NR or
“9999” in Data Table

Frequent “9999”

No Response from Sensor

module. Not connected correctly.

Termination dongle not installed
Bus cable

Computer too slow

RF noise in environment.
RS485 bus cable is faulty

Module RS485 chip faulty

RF noise in environment.

Check the electrical connector on the
sensor module is firmly connected

Install termination dongle

Check RS485 bus cable continuity
Test with a faster computer.

Try to reduce RF noise

Replace bus cable

Remove one module at a time to identify
faulty module and then replace.

Try to reduce RF noise

No communication over
RS232

RS232 cable disconnected

Control Module Failed

Reconnect cable

Replace Control Module

PC Data logging
stopped

USB to serial hub not working

Check USB connectors. Check the serial
hub is present on the device hardware
menu in the PC. If not reload driver
software and re-install.

No data on SD card

Card not correctly installed in slot.

Data logging interval set too
large.

Data card module fault

Turn off Dust Sentry and install card in slot
correctly.

Set logging interval in configuration to a
lower interval.

Send control module to factory for
replacement module.

IP Modem connection
lost

SIM card account in debt

Network down

Pay SIM account

Wait for network
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Signal strength low Install high gain antenna or move
instrument to site with better coverage.

Low Sensitivity Laser is old Laser needs replacing.
The laser current can be Send to your authorised distributor or
measured in diagnostics mode contact Aeroqual technical support.

using Dust Sentry software. If
above 20 mA then fault

Low Sensitivity Dirty optics Optics need cleaning

Send to your authorised distributor or
contact Aeroqual technical support.

High baseline (HO) Dirty optics Optics need cleaning

Send to your authorised distributor or
contact Aeroqual technical support.

Noisy Readings Dirty optics Optics need cleaning

Laser is old Send to your authorised distributor or
contact Aeroqual technical support.

Laser needs replacing.

Send to your authorised distributor or
contact Aeroqual technical support.

Negative readings Purge filter new and shedding Run zero cycles until purge filter no longer
particles shedding particles.
Purge flow zero Adjust purge flow
Purge filter dirty Replace purge filter

Fibre Span has Dirty Optics Optics need cleaning

changed significantly

since installation Laser is old Send to your authorised distributor or

contact Aeroqual technical support.
Laser needs replacing.

Send to your authorised distributor or
contact Aeroqual technical support.

Readings flat Laser failed (check laser current) | Laser needs replacing.

Photo-detector failed Send to your authorised distributor or
contact Aeroqual technical support.

Send optical engine to Met One for
replacement detector and calibration.
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7. Specifications

Measurement technology

Near forward light scattering nephelometer

Range

0-2000pg/m®

Accuracy

+/-(2 ug/m® + 5% of reading)

Cut points available

PM1, PM2.5, PM10 or TSP

Sample flowrate

2.0LPM

Inlet 36cm heated inlet

Alarm Relay, Email and SMS (Optional)
Data logging 2GB SD card (>15 years data storage)
Display 4 Line Alphanumeric

Output data units pg/m®

Averaging Period 1-60 minutes

Reference filter

47mm GFA circular filter (Optional)

Software Data logging & configuration software included
Outputs RS232, 4-20mA / 2-10V (optional)
Mounting Pole, tripod or wall mounting

Wireless communication options

GSM/GPRS modem with GPS; Orbit DATA (cloud-based
DAS)

Meteorological sensor options

Wind speed and direction; temp/RH; rain; pressure; noise
(Class 1)

Environmental operating range

-10°C to +45°C; 0 to 95% RH (NC)

Power requirements

Power requirements Mains 100 - 260V, 18W (standard) or
regulated 12 (+/- 2.5%) VDC with <150 mVp-p ripple and
noise (15W)

IP65-rated Lockable GRP Cabinet: Width 330mm x Depth

Enclosure 187mm x Height 483mm (including solar shield armour &
mounting brackets)

Weight <12kg

Conformity

Certification (Applied for)

7ICERTS

THE ENVIRONMERT AdEmcYY
MINITEING COITHCATON JORIT
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8. Schematic Diagrams

8.1. Pneumatics

8.1.1. Sample Mode

P \f“r SHEATH 0.2LPM

5
e

IMLET + SHEATH
l = 22LFM

) AICFILTERCASEQZ: DUSTSENTRY FILTER HOUSING 1

g AIC VALVEDL: FLOW ADJUSTMENT 2

7 AIC PUMP04: MIRCO VACUUM FUMP FOR QM 1

[ AICCHECKVALVE: CHECK VALVE 1

4 T-PIECE 2

i 3 AIC PUMP02: KNF PUMP FOR PM AND GTMVS 1

2 AQM PMMOD: AOM PM MODULE V5 1

1 AIC PMED180: MD ENGINE WITH SPAN CAL 1

D PART NAME o |

AEROQUAL LTD DUST SENTRY MEPH: PNEUMATIC SCHEMATIC (SAMPLE MODE]
REVISION 1.2 | 19 SEPT 2013 | MOT TO SCALE DRAWMN BY: 5 BENNETT SHEET 1 OF 2

8.1.2. Zero Mode

/-@ INLET PURGE 0 5LPM
—
P %" PURGE 0.5LPM
—
le=
INLET + PURGE
= 0.0lPM
] AICFILTERCASEOZ: DUSTSENTRY FILTER HOUSING 1
& | AICVALVEDL: FLOW ADJUSTMENT 2
7 | AIC PUMPD4: MIRCO VACUUM PUMP FOR IQM 1
[ AIC CHECKVALVE: CHECK VALVE 1
4 | T-PIECE 2
3| AIC PUMPD2: KNF PUMP FOR PM AND GTMVS 1
2| AQM PMMOD: AOM PM MODULE V5 1
1 | AICPMS0180: MD ENGINE WITH SPAN CAL 1
|[+] PART NAME anr
AEROQUAL LTD DUST SENTRY NEPH: PNEUMATIC SCHEMATIC (ZERO MODE)
REVISION 1.2 19 SEPT 2013 | NOTTO SCALE DRAWN BY: S BENNETT SHEET 2 OF 2
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8.2. Electrical

Power Supply
AC PSUPPLYBO/12
ONO==| ===+
EARTH CONNECTED TO OV ! !
b
b
I 1
Modem (optional) Controller ALARM RELAY m“ﬁg;:ﬁgfm:
AIC MDMO03 AQMCM coi | i
T T
I 1
I 1
I 1
| I
b
i i ALARM RELAYS
| i FOR CUSTOMER
! ! WIRING
HliTl:‘ErD Nephelometer [~ ~777777 777" PMFlow Module ~— [~7TTTTTTTTT T T H
I
AICPMINHT acemsoles || e e I
; ] ] ;
| : H | L]
! ] | !
| : ! | 8
: | | '
| 7
| 6
5
4
3
2
1
11 PART NAME aTy
AEROQUAL LTD DUST SENTRY NEPH: ELECTRICAL SCHEMATIC
REVISION 1.2 | 13 SEPT 2013 | NOT TO SCALE DRAWN BY: § BENNETT SHEET1 OF 1
GPRS MOBILE COMMUNICATION USB TO USB TO COMPUTER
SERIAL
SERIAL PORT 1
SMS ALERTS Moder (Optional) SERIAL PORT 2 Cantroller
AIC MDMO3 AQMCM
EMAIL ALERTS
RS485 TWO WIRE COMMUNICATIONS
EIGHT WAY CONNECTION
Nephelometer . PM Flow Module
AIC PME0180 AQM PMMOD
9
8
7
6
5
4
3
2
1
o PART NAME amy
AERDQUAL LTD DUST SENTRY NEPH: COMMURNICATION SCHEMATIC
REVISION 1.2 13 SEPT 2013 NOT TO SCALE DRAWN BY: S BENNETT | SHEET 1 0F 1
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9. Third Party Sensors

9.1. Sensirion T/RH Sensor SHT75

Description: Measures air temperature and relative humidity
Specifications For full details visit the company website www.sensirion.com

Air Temperature

Range -40°Cto +124°C
Accuracy +0.3°C
Resolution 0.01°C
Relative Humidity
Range 0-100 %RH
Accuracy +2 %RH
Resolution 0.1 %RH
9.2. Gill WindSonic
Description: 2-axis ultrasonic wind sensor, measures wind speed and
direction
Specifications: For full details visit the company website www.qill.co.uk
Wind Speed
Range 0-60 m/s
Accuracy 2% @ 12 m/s
Resolution 0.01 m/s
Wind Direction
Range 0-359° (no dead band)
Accuracy 3% @ 12 m/s
Resolution 1°
Mechanical
External construction & LURAN S KR 2861/1C ASA/PC;
protection IP65
Size & Weight 142 x 160 (mm) ; 0.5 Kg

Environmental

. -35°Cto +70°C; <5% to 100%
Operating range

RH
9.3. Met One 034B
Description: 3-cup anemometer and vane designed to measure wind
speed and direction
Specifications: For full details visit the company website www.metone.com
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- Wind Speed
i Range 0-75 m/s
+0.12 m/s @ < 10.1 m/s
Accuracy
+1.1% @ > 10.1 m/s
— Resolution 0.7998 m/s
‘ Wind Direction
. Mechanical 0-360°
Range .
) Electrical 0-356°
I Accuracy +4°
Resolution <0.5°
Mechanical
Finish Clear anodized aluminum
Sensor Weight 0.81kg
Environmental
Operating range -30°Cto +70°C
9.4. Met One MSO
Description: Measures wind speed and direction; air temperature; relative

humidity; and barometric pressure

Specifications: For full details visit the company website www.metone.com

e

Wind Speed

Range 0-50 m/s

Accuracy 2%
v Resolution 0.1m/s

Wind Direction

Range 0-360°

! Accuracy +5°
m—— Resolution 1°

Air Temperature

Range -40°C - +60°C

Accuracy +0.5°C

Resolution 0.1°C

Relative Humidity

Range 0-100%

Accuracy 4%

Resolution 1%

MRK-D-0014, V4

Barometric Pressure

Range
Accuracy
Resolution

500-1100 mbars
+ 2 mbars
0.1 mbar
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9.5. Vaisala Weather Transmitter WXT520

Description:

Specifications:

MRK-D-0014, V4

Measures wind speed and direction; liquid precipitation;
barometric pressure; air temperature; and relative humidity

For full details visit the company website www.vaisala.com

Wind speed and Direction

Speed
Measurement range
Accuracy

Direction
Measurement range
Accuracy

0-60 m/s
+0.3 m/s or 3% (0-35 m/s); +5% (36-60
m/s)

0-360°
+3°

Liquid Precipitation

Rainfall
output resolution
accuracy
Rainfall duration
output resolution
Rain intensity
range
output resolution

cumulative accumulation after latest
reset

0.01 mm, 0.001 inches

5%

counts each 10 s increment when droplet
detected

10s

one-minute running average in ten-
second steps

0-200 mm/h

0.1 mm/h, 0.01 inches/h

Barometric Pressure

Measurement range
Accuracy

600-1100 hPa
+0.5 hPa @ 0 to 30 °C (+32 to +86 °F);
+1 hPa @ -52 to +60 °C (-60 to +140 °F)

Air Temperature

Measurement range
Accuracy @ +20 °C
(+68 °F)

-52 to +60 °C (-60 to +140 °F)
+0.3 °C (0.5 °F)

Relative Humidity

Measurement range
Accuracy

0-100 %RH
+3 %RH (0-90 %RH); +5 %RH (90-100
%RH)
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9.6. Cirrus MK:427

Description:

Specifications:

Class 1 outdoor noise meter

For full details visit the company website
WWW.cirrus-environmental.com

Output Type ‘A’ weighting SPL output in the form
of a 4-20mA loop

Frequency Weighting dB(A) to IEC 61672-1:2002

Time Weighting Factory set to Fast (‘F’) IEC 61672-

1:2002

Automatic Calibration

Electrostatic Actuator System with DC
voltage control

Measurement Range

30 — 100dB(A)

MRK-D-0014, V4

Current Loop Output

lout = 0.1mA/dB

Dimensions 1m length
Weight 4.5Kg
Mounting 240mm x 30mm diameter pole

Mounting Kit provided
(2 U-brackets, 4 nuts, 3 Jubilee Clips)

External Power

+12V DCin

Output Cable

10m as standard
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10. Mounting and Site Positioning Guidelines

It is important that the positioning of the Dust Sentry is suitable so as to

yield data which is representative of that specific location.

10.1. Mounting

The Dust Sentry comes with 2x mounting brackets and 3x U-bolts for 2
inch poles. The same brackets are used for both pole and wall mounting.
To wall mount the Dust Sentry the brackets are screwed into the wall
instead of using the U-bolts.

For pole mounting:

1.
2.

3.
4.

Note: Only one U-bolt is used to secure the bottom bracket

5.

Secure top mounting bracket at a suitable height using 2x U-bolts
provided

Fix lower mounting bracket to the Dust Sentry chassis with
screws

Hang the Dust Sentry on the top mounting bracket

Place U-bolt through lower mounting bracket

Add nuts and washers and tighten the bottom U-bolt into position

10.2. Inlet height

If PM monitoring is related to human exposure, the sampling inlet height should be positioned
in the “breathing zone”. This is located between 2 and 15 meters above ground level.

If PM monitoring is related to specific emission sources, the position of the sampling inlet can
be more flexible. It is more important that there is no obstruction between the approaching air
from the emission source and the sampling inlet.

If more than one Dust Sentry, or any other particulate instrument, is being used at the site, the
height of the inlets should be uniform.

If the Dust Sentry inlet is the highest point at the site, a lightning rod must be installed to
prevent damage to the unit during electrical storms.
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10.3. Measurement Interference

e The meteorological conditions of the site should be taken into consideration when positioning
the Dust Sentry. For example, there should be no obstruction to the air flow in the
predominant wind direction. A minimum clear sky angle of 120 degrees is recommended.

e Theinlet should be at least 1 meter away from any objects that could potentially influence the
airflow characteristics e.g. trees, vertical surfaces or walls.

¢ Avoid overhead high-voltage cables which may cause electrical interference with the
sampling equipment.

¢ Demolition/construction activities and change to normal transport patterns due to road works
etc. can significantly affect the data. Ensure a record of such events is kept to account for
unexpected peaks in concentration.

10.4. Safety

e The intended data capture rate should be considered when positioning the Dust Sentry. If
data capture above 90% is essential, the unit should be located in an area which has 24 hour
access available.

e The positioning should allow for routine maintenance checks to be performed safely by
personnel.

e If using a tripod, ensure the tripod legs are bolted to the ground to prevent the unit from
falling. Ensure the Dust Sentry is in a secure location to avoid vandalism or theft.
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11. Orbit Data

Orbit data is a cloud-based data acquisition and reporting system developed specifically for
Aeroqual’s real-time air quality instruments. Using Orbit, customers are able to access their data
online and in real time. The system comprises a proprietary modem which plugs directly into the serial
port of your instrument. The modem pushes data to the cloud-based server at pre-determined
intervals. Via orbitdata.com end users can access, view, and download the data using a browser on

any internet enabled device.

11.1. Specifications

Modem 3G GSM/GPRS

Global Sim supplied by Aeroqual
SIM card pIEORE }Il'elema?tics
Power requirements 5-30VDC, supplied by instrument
Input RS232
Dimensions 149 x 81 x 31 (mm)
Environmental operating range -20to +70°C
Software Web-based
Browser compatibility Internet Explorer (7+), Chrome, Safari
Alarms Unlimited text/SMS, email
Parameters Up to 20, dynamically configurable

Data Warehouse

RAID, clustered storage, multi-site

Data Format

CSV, XML (FTP only)

Conformity

Fe C€

11.2. Configuring the Orbit Modem

Aeroqual will provide a Serial Port Extender (SPE) which is a GSM/GPRS telemetry modem used at a
remote location to connect between a remote device (with a serial port) and a central computer. The
SPE is more than just a GPRS telemetry modem with an IP stack built in. It has many functions which
ensure that the remote device is always able to communicate with the host system. Aeroqual also

provides a Global SIM which is pre-installed.

To configure using the PC software:

. x|
e Select Setup > Operations
. ) . Monitor ID:

e Select Data Logging period to 5 minutes Data Logang

L] Se|eCt P0||Ing Data Data Logging Period (hh:mm) : I i 00:05 >
i~ Auto Data Report

e Uncheck Use GateTel modem

e Click Save and Close Output Seting
Selected Sensor : IPMID - l

=]
e Select Setup = Configuration st Cunrent I — bl kgt @ofasl: oo
p g Honitor © o < Alarm reset point of trigger {%:): I 8053

Monitor New ID:

e Set MonitorIDto 1
e C(Click Save and Close

Alarm trigger point average period: IS min - l

[¥ Active output on diagnostic

Sensor Numbers:

Used Sensar List:

Sensor Type List:

|¥ Enable alarm relay output
¥ Enable 4-20 mA module

™ Enable M5 message alert
ahle email slert
< [~ UsefEateTel modem

Save | Close |

MRK-D-0014, V4 Page | 43

Aeroqual Dust Sentry User Guide, March 2013



AelOQUAL

11.3. Using the Orbitdata Website

Once the Dust Sentry has been configured with the Orbit Modem the unit can be accessed via
www.Orbitdata.com

o When the site is first accessed a default landing page will be shown

orbitbDATA

Country Region Sub-Region Unit Options

www.harvest.com
New Zealand Auckland Aeroqual Demo Unit

Aeroqual pemo unit
Logged in as: Guest (page last refreshed 6 seconds ago)

Welcome to Orbit Data

Welcome to Orbit Data, brought to you by Aeroqual.

For any technical support issues please contact us via technical@aeroqual.com or through your local distributor.

24 his ending 7:15 Mon 16 Sep 2013 (called 75 seconds ago)

133 E\’:x]??f:gz/gﬂav 878  min -5900‘50
T 9] i
= 699
g 444
194
e e e P e e e Sl -== Zero Line
201 WS (m/s) 3
max18  avg05  min0.3
£ 10l
g
e Select Options = Login and Settings eee—
e Enter your User Name and Password Options
Unit
Note: You can elect to save the login details in your User Options
browser at this point Login and Settings
ago) Normal Graph View
e The system displays “Logged in as: your name” QuickViaw
e Select Go to Graphs T o

Login
This page is protected with a username and password. Please type them in and then click Go.

For help with your username or password please contact us.

User name: Iaeroqual

Password:  [eessesesss|

_Go |

V' save this system's password in your browser (for 365 days).

Aeroqual pemo unit

Logged in as: aeroqual (page last refreshed 3:11 minutes ago)
My System

You are now logged in to your system. This page allows you to change your password and alarm details. Click the button below to log out if you do not
want anyone else using this computer to be automatically logged on:

Log Out | Go to Graphs |
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P10 [padé]

WS [mds)

WD [

o Navigate to your specific site and unit by:
o Selecting the correct country from the drop down menu
o Selecting the Region
o Selecting the Sub-region
o Selecting the Unit

Country | Region Sub-Region Unit Options
New Zealand Auckland Aeroqual Demo Unit

Brazil

o t refreshed 8:20 minutes ago)
Indonesia

Italy

em. This page allows you to change your {

er to be automatically logged on:
UAE

11.3.1. Using the Graphs

Once the correct unit has been selected the default 24 hour graphed data will be shown on the
screen. Above the graphs it will show the time, date and how long since the unit was last called. To
the right of each graph the max, min and average will be shown.

e Click on the graph to zoom in on a specific time interval.
o Hover the mouse over the graph to view the start time and time interval of the graph
to be shown if clicked e.g. “3 hr graph from 3:00pm Mon, 16 Sep 2013".
o Tozoom out press the grey button in the bottom right e.g. “Zoom out to 7 day graph”

Note: The time intervals that can be shown are: 3 months, 1 month, 7 days, 24 hours, 3 hours,
1 hour and 15 minutes.

24 bes from 000 Sun 15 Sep 2013 [UTC+12hrs) 3 hrs from 21:00 Sun 15 Sep 2013 (UTC+ 2his)
. PH10 [ug/ne) 133 P10 (paé)
max134.20 avgB93  min-B.00 T max 13420 avgb095 min8.30
923 E
79 2 ¥
=

23 \ = 58

173 ; J | 334

g o e e e A — A — | - e Lt 8
207 WS ) WS [més]

. 04 03 k]
max 1.8 avg DB min 0.3 max avg ity

4
|
<

03

3503 wo
3603 WD) 300 max 2E60  avg 2E1.0 min 261.0
003 — . L =l e D avg 1D in 1.0 EEEREEEENFE R R REEE TN E
n A 5 . LI, " =
e R R i Fiicaies g W0y
P . SN Ll = 1504
150 . I . 123_
1009 o E
1= W -’-..,_‘__ﬁ- " L 0 T T 1
50 . e = L L <
™ ] 3 s 3
0 T T T T T T T 1 a o & = Zaom out to
g g 3 g 2 g 8 = 3 < g 24 giaph
E & @ & & & o ~ S Zoom out to 3 =
H § 7 day graph
w =
T Click on the grey button to zoom out
Options

e To return to the default view (24 hours) click Options - Normal Graph View
User Options

e Other viewing options are: QuickView, Temperature Graphs Only, Latest Logla 2ad Settiegs

Logout

Data in Text Format, Latest Weather, Smartphone View, and Historical Data.

OuickVi
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11.3.2. Setting Alarms

To set an alarm email Aeroqual at technical@aeroqual.com with the following information:

1. What triggers the alarm (e.g. PM10 concentration > 100ug/m3)
2. What clears the alarm (e.g. PM10 concentration < 80ug/m3)

3. Who to notify in the case of an alarm (e.g. Email sales@aerogual.com or SMS +64 21 123
456)

Once the alarms have been configured they are visible from the Options = Alarm Information view.

Unit's Alarms

Demo Unit PM10—PM10 has PM10 alarms

PM10 alarms:
Alert 100 reset 80 goes to Default roster

Conditional Alarms:

All alarms go to Default roster:
Simon (Email simon.bennett@aeroqual.com)
Logan-Harvest (Email logan.clarke@harvest.com)
Status: from 1 Jan to 31 Dec

11.3.3. Downloading Data

Download Data

Custormn CSV vl Download Data

N H Year Month Day
The data can. be downIo_aded as a CSV file and opened in Excel . e [ ey
from the Orbitdata website.

Duration:  pay
e Click on Options - Data Options - Download Data :::;
s Quarter
H H rYear
e Select the Start Date, Duration and any other customised C st v [EEE TSI B

options required then click Download Data

ISplit Date/Time [

e Open the file as an Excel Spread Sheet. The data will be . ':"St"m' Felds
displayed as seen below: T iy

« Daily
(8 Hourly

Summary: will only show for relevant columns
[ min
[l Average
7 max
™ Total
™ coo
™ recu

Columns: M A
M eM10 (pa/m=)
M ws (m/s)

A B & D E F G H | ] K

1 Time (dd- PM10 (pg/ WS (m/s) WD (®)  Air TempeAir RH (%) Pressure { AN2 (mA) AQ Temp AQRH (%) Battery (V
2 | HEHSHEHE -0.3 1.1 105 15.9 61.8 1010.6 4 28.6 40.2 11.4
3 | s 0 1.3 297 15.8 62.7 1010.6 4 28.5 40.4 11.4
4 | HEHHHEHE 0.1 0.9 77 15.8 63.8 1010.6 4 28.4 40.6 11.4
S | HeHHHHH 0.9 1.3 81 15.7 63.6 1010.6 4 28.4 40.7 11.4
O | HEHHHEEE 0.5 1.3 B0 15.7 63 1010.6 4 28.3 40.9 11.4
7 | s 0.9 0.6 358 15.7 63.9 1010.6 4 28.3 40.6 11.4
o HHHHHHHH 1z bl 9T 1z 8 (== ANAN 8 A a0 201 11 A
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12. Appendix

12.1. Warranty

Please review the Aeroqual Warranty Policy on our website at www.aeroqual.com

12.2. Technical Support

Technical information, service and spare parts are available through your distributor. In addition,
worldwide technical support is available from Aeroqual Ltd. Please contact Aeroqual Technical
Support by email: technical@aeroqual.com. This will generate an automatic ticket and your enquiry
will be addressed as quickly as possible by a qualified service person.

Aeroqual Limited

109 Valley Road, Mt Eden, Auckland 1024, New Zealand
Phone: +64 9 623 3013

Fax: +64 9 623 3012

Email: technical@aeroqual.com

12.3. Declarations

Copyright Aeroqual Limited. All rights reserved. Reproduction, transfer, distribution or storage of part
or all of the contents of this document in any form without the prior written permission of Aeroqual
Limited is prohibited.

“Aeroqual”’ and “Aeroqual Limited — Making the Invisible Visible” are registered trademarks of
Aeroqual Limited. Other product and company names mentioned herein may also be trademarks or
trade names.

Aeroqual operates a policy of continuous development. Aeroqual reserves the right to make changes
and improvements to any of the products described in this document without prior notice.

Under no circumstances shall Aeroqual be responsible for any loss of data or income or any special,
incidental, consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no
warranties of any kind, either express or implied, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose, are made in relation to the accuracy, reliability or
contents of this document.

Aeroqual reserves the right to revise this document or withdraw it at any time without prior notice. The
availability of particular products may vary by region. Please check with the Aeroqual dealer nearest
to you.

© Aeroqual Limited 2013. All rights reserved.

1. The Aeroqual Dust Sentry complies with EN 61000-6-1:2001

2. The Aeroqual Dust Sentry complies with EN 61000-6-3:2001

3. The Aeroqual Dust Sentry complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) these devices may not cause harmful interference, and (2) these
devices must accept any interference received, including interference that may cause
undesired operation.

4. The Aeroqual Dust Sentry is pending MCERTSs for indicative ambient particulate monitor

(€ @ F M
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= USE SENSIBLY
Use the Aeroqual DUST SENTRY instrument only as per this user guide.

= USE AEROQUAL APPROVED SERVICE
Only approved service personnel must work on this product.

= ACCESSORIES
Use only approved accessories. Do not connect incompatible products.

= CONNECTING TO OTHER DEVICES
When connecting to any other device, read the appropriate user guide for detailed safety

instructions. Do not connect incompatible products.
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